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Overview
Caret 5 is a software application for analyzing, manipulating, and viewing surface and volume models of
the cerebral and cerebellar cortex and for displaying experimental data on the surfaces and volumes.
Caret 5.5 (September 2006 release) has many visualization procedures covered in the Caret Tutorial – the
Basics (September, 2006), referred to herein as ‘the Basics document’. The current ‘User’s Guide’ covers a
number of additional analysis options. It assumes that the
user is familiar with Caret 5.5 capabilities covered in ‘the
Basics’ document. Each section contains an explanation of
functionality followed by tutorial steps to demonstrate the
functionality. The document can be followed in a linear
fashion, or by skipping to topics of particular interest.
As in the Basics document:
•

All tutorial steps are identified by bullets.

•

Actions the user should take are in italics.

•

User-interface components are in the Arial font.

Downloading and installing Caret 5 software.
See Appendix 1 of the Basics document
(Caret_Tutorial_Basics_Sept06.pdf in the SumsDB
Tutorials directory)

Figure 1 - Fiducial Surface, Flat Surface, and
Volume with fMRI

Additional Source of Help for Caret
•

The official Caret website, http://brainmap.wustl.edu/resources/caretnew.html.

•

The Caret User’s List, http://brainmap.wustl.edu/resources/caretnew.html#Help.

•

Caret Tips, available on Caret’s Help Menu.

•

Caret Help, available on Caret’s Help Menu. Provides a short description of all toolbar and menu
items in addition to other information. Also, this document and the Basics document are accessible
as html documents from within Caret help.

•

All of the toolbar controls contain “tooltips”. Rest the mouse over the control and a tooltip with a
description of the control will pop-up. The tooltip is removed when the mouse is moved.

•

Additional Caret tutorials and datasets, available on SumsDB
(http://sumsdb.wustl.edu/sums//directory.do?id=707139.

General comment. This tutorial is an ‘interim adaptation of an older (March 2005) tutorial in which
standard-mesh surface representations, the PALS population-based atlas, and scenes were not available.
Hence, aspects of this are covered in the ‘old-fashioned’ way.

Obtaining Caret analysis procedures data set
The data set for use with this tutorial is available in “zip” format from SumsDB (http://sumsdb.wustl.edu).
Users should follow the link http://sumsdb.wustl.edu/sums/directory.do?id=6594259. On the SumsDB web
page, there is column named name containing the file name: CARET_5.5_USER-GUIDE_ANALYSES.tar
. To the left of this name in the action column is a download icon. Select this icon, which will popup a
menu, and select download to automatically start downloading the archive (set of files).
After downloading the data set, the archive needs to be uncompressed. Linux and Macintosh users should
run the command unzip CARET_5.5_USER-GUIDE_ANALYSES.tar. Windows XP users should place
the mouse over the downloaded file and press the right mouse button. From the popup menu, choose
Extract All and follow the prompts. As an alternative, Windows user’s may extract the files by running
caret_unzip CARET_5.5_USER-GUIDE_ANALYSES.tar (provided the Caret installation’s “bin”
directory is in the user’s PATH environment variable.
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Starting Caret 5 and Opening a Specification File
•

Change to the CARET_5.5_USER-GUIDE_ANALYSES directory

•

Change to the HUMAN_DATA/RIGHT-HEM subdirectory

•

Launch Caret
See Section 1.1 of the Basics document if you need help in launching Caret from a Linux,
Windows, or Mac OSX platform.

•

Press Select All (as noted above, no scenes are available)

•

Press Border, then de-select the border color and border projection files

•

Press Cancel

Setting Preferences
(See also Section 1.5.1 of the Basics document)
The preferences dialog is launched by selecting File: Preferences (Caret 5: Preferences on Macintosh). The
preferences dialog allows adjustment of settings that are preserved after Caret 5 is exited. Some of the
available preferences are:
-

Surface Background Color sets the background color of the Main Window and all of the Viewing
Windows. The three values are for the red, green, and blue color components. The values range from 0
to 255.

-

Surface Foreground Color sets the color used for text occasionally displayed in the main window
such as number s for the palette’s color bar when displaying functional data. If you make the
background and foreground colors that same you will not see anything drawn in the foreground color.

-

Light Position is the position of the light that enables the surface to be shaded.

-

Mouse Speed enables the effect of the mouse, such as in surface rotation, to be adjusted.

-

Iterative Update adjusts the frequency with which the surface is updated during some iterative
operations such as smoothing.

-

Image Capture provides two selections for the method used to capture images from the Main
Window. The default value is preset based upon the operating system and, in most cases, should
not need to be changed.

-

Debug Enabled enables debugging message to be printed when this is selected. Turning this on
may be helpful if you are having a problem with Caret and the messages printed may be included in
your bug report.

-

Debug Node A node number for which debugging information is printed when debugging is
enabled.

-

Display Lists Enabling display lists may significantly improve the manipulation of the surfaces.
Leave this item on unless error message are printed regarding OpenGL.

-

Speech is available only in Macintosh OSX versions of Caret. When set to Off, no speech is
produced. When set to Normal, announcements are made during or at the completion of some
operations. In addition, if an error, information, question, or warning dialog is displayed, the type
of the dialog is announced. When Speech is set to Verbose, all Normal announcements are made
plus the textual contents of error, information, question, and warning dialogs.

-

Text File Float Precision – This parameter determines the number of digits to the right of a
decimal when floating point numbers are written to a Caret text format data files. This can be an
issue when using the “caret_morph” program to perform command line multi-resolution morphing
as the results may be different than those obtained by running multi-resolution morphing in Caret 5
immediately after flattening the surface. For maximum precision, set this value to 24. Using binary
files eliminates the need to set this parameter.
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-

File Writing Preference – Determines the format (text or binary) in which Caret 5 data files are
written. When set to “No Preference” a data file is written in the same format as it was read from
or text if it is a new file. The advantage of binary files is that they are much faster to read. Reading
a text data file takes about four times as long as it does to read a binary data file. Binary data files
are written so that they are readable on any computer for which Caret 5 is available. The command
line program “caret_file_convert” may be used to convert Caret 5 data files between text and binary
format.

-

Random Seed – Some of the statistical algorithms use the computer’s random number generator.
This allows the user to set the “random seed” for generation of random numbers.

The Mouse
The mouse is used to perform a number of operations in Caret 5. These operations include adjusting the
view of the surface (rotate, scale, and translate), identifying data items, and drawing borders and cuts. The
computer systems on which Caret 5 runs have one, two, or three mouse buttons. To maintain consistency,
most mouse functions are identical across computer systems. Almost all mouse operations involve using
the left (or only) mouse button, sometimes combined with the shift or ctrl (Apple on Macintosh) keys.
Listed in the status bar at the bottom of the Caret 5 main window are the functions of the mouse based upon
the current mouse mode. Caret 5 also has a pop-up menu that is displayed when the user presses the right
mouse button (on Macintosh, press the mouse while holding down the control key). The contents of this
menu depend upon what is under the mouse, surface as a border, focus, or surface, at the time the mouse
button is pressed.

Visualizing Surfaces
If you are not comfortable with various aspects of viewing surfaces in different configurations and windows
using the toolbar, mouse, and menu options, you can spend some time reviewing them here, or else visit the
Basics document (Sections 1.1 – 1.10).

Visualizing Volumes
(See also Section 1.12 of the Basics document)
Besides displaying surfaces, Caret 5 can also display volumes.
•

In the Main Window, select Model: VOLUME.
The default view of the volume sets the viewed slices so that the
slices intersecting at the origin are shown. The origin is
commonly set at the Anterior Commissure (AC), however, for
some volumes the origin may be set differently. Caret is capable
of displaying both orthogonal (right angle or the standard coronal,
horizontal, and parasagittal) and oblique (any axis) volume slices.
When viewing a volume you will notice changes in the Toolbar
compared to when a surface was displayed.

Toolbar controls for volume visualization:
-

View - Places the mouse in View Mode to that the volume may
be translated and zoomed.

Figure 2. Main Window Volume
Viewing Horizontal Slice

-

R – Resets the view of the volume resetting translation and
zooming and resets the slices to the default slices (typically the
anterior commissure).

-

Slice View Control – Allows selection of viewing a coronal, horizontal, or parasagittal slice, all
(coronal, horizontal, and parasagittal) oblique, x-oblique, y-oblique, z-oblique, and oblique all (x, y,
and z).
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-

Parasagittal Slice Control

-

Coronal Slice Control

-

Horizontal Slice Control

-

D/C – Pops up the Display Control Dialog.

•

Spec – Pops up a dialog that allows a data file from the current Spec
File to be quickly loaded.

•

Press the Toolbar:R button to reset to the default view of a volume.

•

Press the up and down arrows in the rightmost Slice Control to change
the horizontal slice that is displayed.

•

Use the Slice View Control (immediately to the right of the “R” toolbar
button) to switch to a coronal [C (XZ)] view and press the arrows in the
middle Slice Control to change the coronal slice that is viewed.

•

Switch to ALL view to see a simultaneous view coronal, horizontal, and
parasagittal sections along with a fiducial surface.

•

Switch to Oblique view. Place the mouse over the volume slice, hold
down the left mouse button, and drag the mouse to start rotating
volume. Use the rightmost slice control to step through some slices.

•

Switch back to a horizontal [H (XY)] view. Press the R button in the
Toolbar to reset the view of the volume.

•

Press the D/C button in the Toolbar to launch the Display Control
Window. Switch to the Volume – Overlay/Underlay page. Press the
Settings tab. Check the checkbox next to Montage to see a series of
horizontal slices. Adjust the Montage settings as desired.

•

Uncheck the Montage checkbox.

Figure 3 - Oblique Volume Viewing

Surface and Volume Interaction
Caret 5 provides the ability to perform surface and volume interactions. This
allows the user to identify a location on a surface and, as a result, the volume
slices and crosshair will change to highlight the location in the volume.
Likewise, if a voxel is identified in the volume, the node nearest that voxel will
be highlighted on the surface with a green symbol and a large blue cross will
briefly appear.
•

Set the Main Window so that it shows the VOLUME.

•

If a Viewing Window is not open at this time, select Viewing Window 2
from the Window Menu.

•

Set the surface displayed in Viewing Window 2 to the FIDUCIAL surface.

•

Click the mouse in the volume around an area containing cortical matter
in the right hemisphere. Note that since the surface is a right
hemisphere surface, clicking in the left hemisphere of the volume will
result in an ID symbol along the medial part of the surface.

•

Click the mouse on the surface in the viewing window. Notice that
the view of the volume is changed to the location corresponding to
that identified on the surface.
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Figure 4 – All Slice Volume Viewing

Figure 5 - Montage Volume Viewing

Using the Display Control Dialog
(See also Section 1.7 of the Basics document)
The Display Control Dialog is used to control the coloring of surfaces and volumes using the loaded data
files. At the top of the dialog a control facilitates selection of different control panels for each type of data.
On the most commonly used panel, Overlay/Underlay – Surface, each row has controls for different types
of surface attribute data that are used to color the surface. Some items will be disabled (grayed out)
depending upon the data types that are loaded. On the right half of the dialog are three columns labeled
Primary Overlay, Secondary Overlay, and Underlay. A different data type may be assigned to each of the
overlays and the underlay enabling the display of several types of data simultaneously. The primary
overlay takes precedence over the secondary overlay, which takes precedence over the underlay.
In the Main Window, set the viewed brain model to the FIDUCIAL
surface.
•

Press the D/C button in the Toolbar to display the Display
Control Dialog and drag the Display Control Dialog to the
side of the Main Window.

•

If the Display Control Dialog is not set to Overlay/Underlay
– Surface, go ahead and select it.

Surface Overlay and Underlay Data Types
Each of the surface attribute data files is similar to the rows and
columns of a spreadsheet with one row for each node and one or
more columns of data. The data types available for coloring a
surface are:
-

Areal Estimation is essentially a “fuzzy paint file”.
That is, the boundaries of identified regions are
known to be in error and this is reflected in the
coloring of the surface near the boundaries between
regions.

Figure 6- Display Control Dialog Overlay
Underlay - Surface Page

-

CoCoMac (Collations of Connectivity data on the
Macaque Brain) is a database that combines the results of many studies of cortical
connectivity in the Macaque. See http://www.mon-kunden.de/cocomac/) for more
information.

-

Metric is simply one or more floating point (real) numbers per surface node that is colored
using a palette file. Typically metric files contain the results of functional neuroimaging
studies.

-

Paint contains one or more discrete (integer) values per node that index into a table of
names that are typically used to identify regions of the surface. The names in the table are
matched to names in the Area Color File to color the surface nodes. Columns in the paint
file represent partitioning schemes for different cortical areas.

-

Probabilistic Atlas contains partitioning schemes from several subjects. The surface is
colored to show correlation between the different partitioning schemes.

-

RGB assigns red, green, and blue color components to each node.

-

Surface Shape is essentially the same as metric data except that the surface is colored with
shades of gray. Typically surface shape files contain data that represent the shape of the
surface such as curvature (folding), or sulcal depth.

-

Topography contains polar angle and eccentricity mappings for each node in the surface.
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-

Crossovers show the results of a crossover check (Surface Menu: Measurements: Crossover
Check).

-

Sections – If a number is entered in the text box, that section will be highlighted in blue. If
the number is followed by an “X”, every nth section will be highlighted, i.e., a value of
“10X” results in every 10th section being highlighted.

-

Edges displays the edges in a surface in blue. Edges are determined by Surface: Topology:
Classify Nodes.

-

Geography Blending requires a column in the paint file named Geography. Nodes whose
geography contains the name “SUL” are darkened to reveal the sulci when other surface
node coloring schemes are used. The Geo Blend factor controls the contrast between gyral
and sulcal domains.

Viewing Paint and Metric Surface Data
(See also Sections 1.16, 1.18, 1.22 of Basics document)
By default, Caret 5 initializes the primary and secondary overlays to “none” and the underlay to the first
column in the surface shape file. If there is no surface shape file, Caret 5 will determine the mean curvature
(folding) of the first fiducial or raw surface that was loaded.
•

Set the Main Window so that it displays the FIDUCIAL surface.

•

Set the Viewing Window 2 so that it displays a FLAT surface.

•

In the Display Control Dialog, set the Primary Overlay to Paint by selecting the radio button at the
intersection of the Paint row with the Primary Overlay column.

•

If the Paint selection is not Lobes, select Lobes using the control in the Paint row. The surface is
now colored with pastel colors showing the cortex’s lobes.

•

Notice that the flat surface no longer shows the surface folding, so, set the Underlay to Geo Blend
(Geography Blending) making the sulci visible by shading them in a darker color.

•

Change the Paint selection to Brodmann, which will shade each of the Brodmann areas in a
different color. Notice the abrupt boundaries of each of the Brodmann areas.

•

Change the Primary Overlay to Areal Est (Areal Estimation). Areal Estimation is similar to Paint
but takes into account the fact that the boundaries are not 100% accurate and shades the surface to
reflect this inaccuracy.

•

Set the Primary Overlay to Metric and the Underlay to Shape (Surface Shape).

•

Change the selected Metric to Attention Shifts pop avg using the control in the Metric row.

•

Press the ? button in the Metric row to display comment information about this functional data. At
the bottom of the comment data is a hyperlink, which, when pressed, displays the abstract of a
paper describing the study (UNIX users may need to set the environment variable
CARET_WEB_BROWSER or set the web browser using the Preferences Dialog selectable from
the File Menu).

•

Press the Close button on the Comment Editor Dialog.

Volume Overlay and Underlay Data Types
(See also Section 1.17 of Basics document)
Several types of volume files may be loaded into Caret 5. Similar to surfaces, several different types of
volumes may be displayed simultaneously using two overlays and an underlay. The data types available for
coloring a volume are:
-

Anatomy containing a structural MRI.

-

Functional containing functional data such as PET or fMRI (analogous to a surface metric
file).
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-

Paint whose voxels are indices into a table of names that identify regions of the volume
(analogous to a surface data Paint file).

-

RGB containing RGB (red, green, blue) components for each voxel.

-

Segmentation containing voxels that denote a region of interest in the volume.
Segmentation volumes are currently used for
volume of interest operations and will be
used when SureFit’s segmentation
capabilities are added to Caret 5.

•

Using the control at the top of the Display Control
Dialog, switch to Overlay/Underlay - Volume.

•

Set the Primary Overlay to Function-View. Check to
see that the selected functional volume is the
Corbetta Attention Shift volume.

•

While still viewing the Attention Shifts pop avg
Metric data on the surface, set the Viewing Window so
that it shows VOLUME.

•

Click on the peak activations (yellow and orange) on
the surface to see the VOLUME view to jump to the
corresponding location in the volume (and vice
versa). The activations may be easier to see on the
inflated surface.

•

Figure 7– Display Control Dialog
Overlay/Underlay - Volume Page

To see how the surface and volume are aligned, press
the Show Surface Outline check box in the
Miscellaneous frame of the Overlay/Underlay – Volume panel on the Display Control Dialog.

Viewing Functional Volumes
(See also Section 1.22 of the Basics document)
Functional volumes are colored using the parameters on the Metric panel of the Display Control Dialog. If
a metric file is loaded, it is possible that a functional volume may not be colored correctly. This will occur
if the selected metric was not mapped from the selected functional volume. If the Color Mapping is set to
Auto Scale and the selected metric and the selected volume are different measurements, the effect on the
functional volume’s coloring may be even more conspicuous. While this may seem inconvenient or prone
to error, it results in voxels and surface nodes having the same value being colored identically.
•

Set the Viewing Window to show the FLAT surface.

•

Set the Main Window to the FIDUCIAL surface.

•

Set the Display Control Dialog back to Overlay/Underlay Surface.

•

Set the Primary Overlay to Metric.

•

Change the Metric selection to view – VISUAL MOTION Lewis et al.

•

Press the ? button to view information about the functional data including a URL linked to the
data’s publication.

•

Switch the Display Control Dialog from Overlay/Underlay – Surface to the Metric panel which
allows greater control over the display of Metric (Functional) data.

•

Press the Selection tab to list all of the metric data that is loaded.

•

Press the radio button in the Thresh column to threshold – VISUAL MOTION. Leave the View
column set to view – VISUAL MOTION.

•

Press the Settings tab.

•

In the Threshold frame, set the Positive value to 0.2, so that no positive values less than 0.2 are
displayed, and press the Apply button at the dialog.
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•

In the Display Mode frame, press the radio button next to Positive so that only positive values are
displayed.

•

Press the checkbox next to Display Color Bar in the Palette frame.

•

Set the Display Control Dialog to Overlay/Underlay – Surface.

•

Near the bottom of the Display Control Dialog is a row named Lighting Enabled. Uncheck the check
box in the Primary Overlay Column and notice that the functional data no longer has lighting
applied to it, and thus reflecting its true color.

•

Set the Secondary Overlay to Paint and the Underlay to Geo Blend while leaving the Primary
Overlay set to Metric.

•

Change the selected Paint to Visuotopic to see identified visual areas under and around the
functional data (this is best viewed on the flat map).

The Identify Window
(See also Section 1.18.1 of the Basics document)
The Identify Window may be used to better understand the relationship between the functional data and the
visuotopic areas. In the Identify Window, information about the identified point on the surface is presented.
Buttons in the toolbar of the Identify Window are used to filter the information that is printed in the Identify
Window. Placing the mouse over the buttons will display a tooltip describing the filtering function of the button.
Identify Window Toolbar Buttons:
-

•

CID – Removes all node identify symbols (green squares) on all of the surfaces.
Clear – Erases the contents of the Identify Dialog.
Copy – Copies text highlighted by mouse dragging to the clipboard for pasting into other programs.
B – Allows/disallows display of border identification.
C – Allows/disallows display of cell identification.
F – Allows/disallows display of foci identification.
V – Allows/disallows display of voxel identification.
C – Allows/disallows display of node coordinate.
X – Allows/disallows display of node section.
L – Allows/disallows display of node latitude/longitude.
P – Allows/disallows display
of node paint.
p – Allows/disallows display
of probabilistic atlas.
R – Allows/disallows display
of node RGB paint.
M – Allows/disallows display
of node metric.
S – Allows/disallows display
of node probabilistic atlas.
A – Allows/disallows display
of node areal estimation.
T – Allows/disallows display
Figure 8 - Identification Dialog
of node topography.
All-N – Turns all of the node specific
allow/disallow buttons on or off.
SID – Toggles between allowing and not allowing green ID symbols to be displayed on the surfaced
when an ID Node operation is performed.
The number on the far right is the number of digits to the right of the decimal point that will be
shown when numeric data is displayed.

Click the left mouse button over one the functional activation that is also over a red visuotopic area.
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•

Press the Clear button to remove any existing information.

•

Press the All button to turn off all of the surface data and then press the P button to display Paint
information.

•

Click the left mouse over the activation that is overlayed on the red paint area (If you click over an
existing green identification symbol it will be turned off, so, if this is the case, click the left mouse
button again). Displayed in the Identify Dialog will be all of the
information from the Paint file for the identified node. The 4th
column will identify the visuotopic area as Visuotopic.MTplus.

Combined Surface and Volume Viewing
(See also Section 1.12 of the Basics document)
This viewing mode shows volume slices in each axis along with the
surface.
•

Using the Display Control Dialog, set the panel to
Overlay/Underlay – Surface.

•

Set the Primary Overlay to Metric, the Secondary Overlay to No
Coloring, and the Underlay to Shape.

•

Set the Metric to Attention Shifts Pop Avg.

•

Set the Display Control Dialog to the Metric panel.

•

Set the Display Mode to Both and set the Positive Threshold to
0.0. Press the Apply Button.

•

Set the Display Control Dialog panel to Overlay/Underlay –
Volume.

•

Set the Primary Overlay to Functional, the Secondary Overlay to No Coloring, and the Underlay to
Anatomy.

•

In the Main Window, use the Model Selection Control to select SURFACE VOLUME.

•

Press the Toolbar:L button to see a lateral view.

•

In the Toolbar, change the rotation axis to XY (the combo box
to the left of the D/C button).

•

While holding down the left mouse button, move the mouse
slowly from right to left and down slightly so that all three
slices and surface are visible.

•

On the Display Control Dialog, set the panel to Surface and
Volume.

•

Press the check box next to Show Primary Overlay in the
Volume Overlays frame so that the functional data is displayed
on the volume slices. You should see an image like that in
Figure 9. The volume slices can be turned off and the display
slices numbers adjusted in the Anatomy Volume frame.

•

Click the check box next to Show Surface in the Surface frame
so that the surface is not displayed.

Figure 9 - Main Window Surface
and Volume Viewing

Figure 10 - Main Window Surface
and Volume Viewing Functional
Voxels

•

Press the check box next to Show Volume Cloud in the
Functional Volume frame to show all of the functional voxels in
their 3D locations.

•

Use the mouse to rotate the surface (while holding down the left button) or the standard view
buttons in the Toolbar to change the view.
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•

Turn the surface display back on by pressing the check box next to Show Surface to visualize the
relationship of the voxels to the surface similar to that in Figure 10.

Viewing Three Metric (Functional) Data Sets Simultaneously
At times, it may be desirable to view several metric columns simultaneously. This is accomplished by
converting the three metric columns into an RGB paint file where one metric column is assigned to each of
the color components (red, green, and blue).
There are three sections in the Metrics to RGB Paint Dialog (Figure 11.). The RGB Paint section allows the
user to choose an existing column in the RGB Paint File or to create a new column. In addition, a comment
may be entered for the column.
The Metric Selection section allows the user to choose up to three metric data columns for conversion to
RGB Paint. Both negative and positive values may be stored in an RGB Paint file column, however, the
display of positive and negative values is mutually exclusive. As a result, both the Neg Max and Pos Max
values are mapped to the full intensity of the color component. When a metric column is selected in the
Metrics to RGB Paint Dialog, Neg Max is initialized to the most negative value in the metric column and
Pos Max is initialized to the most positive value in the metric column. Considering just the positive metric
values, any metric value greater than or equal to Pos Max is mapped to full color intensity. A metric value
of zero is mapped to zero color intensity (black). Values between zero and Pos Max are linearly
interpolated to an intensity between black and the full color intensity. Using a very small Pos Max, say
0.001, would result in all of the metric data being mapped to the full color intensity with no darker shades
of that color.
The Threshold Selection section allows each of the metric columns selected in the Metric Selection section
to be thresholded. This is optional and the thresholding column for a color component may be different
than the corresponding color component in the Metric Selection section. By default, the Positive and
Negative thresholding values are zero which results in no thresholding. If the positive metric value for the
selected threshold color component is less than the Positive thresholding value, the metric value is mapped
to zero intensity (black).
•

Set the Main Window surface to FLAT using the Model Selection Control.

•

Select Attributes:Metric: Convert Metric to RGB Paint.

•

In the RGB Paint frame, leave the column set to Create New Column and set the name of the
column to “Functional”.

•

In the Metric Selection frame, set Red to
Attention Shift Pop Avg, Green to Eye
Movements Pop Avg, and Blue to view –
VISUAL MOTION.

•

In the Threshold Selection frame set Red to
Attention Shift Pop Avg, Green to Eye
Movements Pop Avg, and Blue to threshold
– VISUAL MOTION. Set the Red and
Green Positive thresholds to 3.5 and the
Blue Positive Threshold to 0.1. This will
eliminate metric values that are not of
statistical significance.

•

The dialog should appear like that in Figure
11. Press the Apply button followed by the
Close button.

Figure 11 – Metrics to RGB Paint Dialog

•

On the Display Control Dialog’s Overlay/Underlay – Surface panel, set the Primary Overlay to RGB,
the Secondary Overlay to No Coloring, and the Underlay to Shape.

•

Set the RGB selection to Functional on the Overlay/Underlay – Surface panel of the Display Control
Dialog.
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•

Switch to the RGB Paint panel on the Display Control Dialog.

•

Turn off the Blue channel by unchecking its check box.
Areas of the surface that are red indicate activity during the Attention Shift task but not
during the Eye Movement task. Likewise, areas of the surface that are green indicate
activity during the Eye Movement task but not during the Attention Shift task. Areas in
yellow indicate activity during both the Attention Shift and Eye Movement tasks.

•

Press the ? button in the Red row to show comment information that was automatically transferred
from the Metric file.

•

Turn off the Red channel by unchecking its check box.

•

Enable the Blue channel by checking its check box, setting its Threshold to 0.04, and pressing the
Apply Button. Areas colored in cyan indicate activity during both the Eye Movement and Visual
Motion tasks.

Importing and Exporting Files
Caret 5 supports the importation of non-Caret 5 data files and the export to non-Caret 5 data files. To see a
list of file types supported for import and export, select either File: Import Data File or File: Export Data File.
The types of files supported are listed in the File Type control. Caret 5 does support importing surfaces
from programs such as Brain Voyager and Free Surfer.

Importing FreeSurfer Files into Caret.
Caret provides options not only for importing FreeSurfer files (and other file types), but also for additional
processing that provide useful ‘value-added’ surface representations. Most notably, landmark-based
surface-based registration to the PALS atlas can be done without repeating the segmentation and initial
surface reconstruction processes if these have already been done in FreeSurfer.
In brief, these capabilities include:
- Menu options as well as command-line options to import/convert FreeSurfer geometry [and other]
files to Caret format.
- Menu options as well as command-line options to generate mid-thickness (layer 4) coordinate
files (by averaging the smoothwm and pial FreeSurfer files).
- Command-line generation of sulcal depth, folding, and ‘geography’ files that are conceptually
similar to the FreeSurfer ‘curv’ and ‘sulc’ files but have some advantages.


Launch Caret from a directory that contains FreeSurfer surfaces (a right hemisphere rh.* in the example
here).



Select Toolbar: File: Import File: FreeSurfer Surface Ascii Surface File: rh.smoothwm.asc
Import Selections: Check the Right Hemisphere box and leave Import Topology and Import
Coordinates checked.

•

Select File name: rh.smoothwm.asc

•

Press Open

•

Select File: Save Data File
File type: Topology Files
Save As Type: Closed
File name: Human.<Case>.R.CLOSED.<NodeNumber>.topo
Including the number of nodes in file names of files belonging to a common ‘surface family’ is a useful
way to quickly ascertain compatibility across files.

•

Press Save
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Would you like to create a spec file? Yes.
Species: Human
Subject: <CASE>
Hemisphere: Right
Space: Other
Category: INDIVIDUAL
•

Press OK

Accept default filename for spec file by pressing OK.
•

Select File: Save Data File

•

Press Save

File type: Coordinate Files
File name: Human.<CASE>.R.SMOOTHWM.<NodeNumber>.coord
Save As Type: Fiducial
Hemisphere: Right
Coord Frame: Native
Orientation: Left Posterior Inferior

Several additional FreeSurfer files that are useful to import have already been pre-imported in order to save
you time.
Tips. Several tips to bear in mind when importing multiple FreeSurfer Files into Caret.
(i) When importing multiple surface files from the same hemisphere, you only have to save the topology
file once
(ii) When saving multiple Caret files, you can save time by selecting one file name, then just changing the
relevant part of it (e.g., File name: Select Human.<CASE>.R.SMOOTHWM.<NodeNumber>.coord, but
backspace over SMOOTHWM and type PIAL, so resulting filename reads
"Human.<CASE>.R.PIAL.<NodeNumber>.coord")
(iii)When importing curvature files as surface shape Caret currently filters only for ‘*, curve, asc’ files. This
glitch will be fixed soon. In the meantime. . . .
(iv) You cannot import files having a different number of nodes (e.g., an ‘rh.occip.patch’ file when
rh.smoothwm is already loaded).
(v) For a command-line utility that streamlines this process, see
http://brainvis.wustl.edu/pipemail/caret_users/2006-February/000686.html

Generating a mid-thickness fiducial surface by averaging gray/white and pial surfaces
The imported FreeSurfer data files have been assigned to a Caret spec file.
• Select File: Open Spec File: Human.<CASE>.RIGHT.<NodeNumber>.spec.

• Press Select all files and press Load.
• Select Surface: Create Average Coordinate File and select Add
• Select both Human.<CASE>.R.PIAL.<NodeNumber>.coord and
Human.<CASE>.R.SMOOTHWM.<NodeNumber>.coord.
• Press Open
•

Change Output Coordinate File from “average.coord” to “Human.<CASE>.R.FIDUCIALMidThickness.<NodeNumber>.coord”

• Deselect: Create Sample Standard deviation

• Press Apply, then press OK on pop-up that says it’s been created, then press Close.
• Select File: Open Data File
File type: Coordinate Files
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File name: Human.<CASE>.R.FIDUCIAL_MidThickness.<NodeNumber>.coord and press
Open.
• Select File: Save Data File
File type: Coordinate Files
Save As Type: Fiducial
Hemisphere: Right
Coord Frame: Native
Orientation: Left Posterior Inferior
File name: Human.<CASE>.R.FIDUCIAL_MidThickness.<NodeNumber>.coord
• Press Save, then Yes to Overwrite Existing File

Borders
Borders are used to delineate regions of a surface. There are two types of borders, open and closed. Open
borders are simply a set of connected line segments. An example of using an open border is during
flattening of a full hemisphere in which open borders denote where cuts in the surface should be made.
Closed borders are similar to open borders but the last point in the border connects to the first point in the
border, thereby enclosing a region of the surface. During surface flattening a closed border is used to
enclose the medial wall so that it may be removed. Closed borders are also used in region of interest
operations described later in this document. Display of borders is controlled using the Display Control
Dialog. The Main border sub-panel allows the display of borders, as a whole, to be turned on or off and
control over the drawing style of borders (points or lines). The Name sub-panel permits the display control
of borders with identical names and the Color sub-panel permits display control of borders by the assigned
color. Operations on borders are accessible through the Layers: Borders menu.
Borders are stored in two types of files, Border Files and Border Projection Files. A border file stores
borders as sets of three-dimensional points that are for use with a specific surface coordinate file. Each
border file is assigned a type (fiducial, spherical, flat, etc) just like a coordinate file. When a border file is
loaded (say a flat border file), it is displayed only on surface of a matching type (in this case a flat surface).
Border Projection files store each
border point in relation to three
nodes in the surface and
Barycentric Coordinates within
those three nodes. This allows a
border projection file to be
displayed on any type of surface
(fiducial, flat, etc) for an
individual.
Figure 12- Brodmann Borders on Fiducial and Flat Surfaces

•

If no borders are loaded, load border color and border projection files as described in the Opening
Data Files section of this document.

•

View several of the surfaces using the Model Selection Control and notice that since a border
projection file was loaded, the borders appear on all of the surfaces.

•

Set the Main Window so that it displays the FLAT surface.

•

Change the panel on the Display Control Dialog to Border and press the Color tab.

•

Press the All Off button to disable the display of all border colors.

•

Press the LAT and LONG check boxes to display latitude and longitude borders (latitude and
longitude is a spherical coordinate system often used for navigating about the earth).

•

Disable the display of LAT and LONG and select the Brodmann check box to see borders that
enclose the Brodmann areas.

•

To see which areas a Brodmann border delimits, click the left mouse button over a border to
perform an ID border operation. In most cases, two borders will be listed in the Identify Dialog
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since there are actually two borders, one superimposed on the other, each enclosing the respective
Brodmann area.
Drawing an Open Border
• Select Layers:Borders: Delete All Borders and press the Yes button in the Confirmation Dialog.
This will eliminate the numbers borders currently loaded.
•

Select Layers:Borders: Draw Borders.

•

Drag the Draw Borders Dialog off of the Main Window.

•

In the Draw Borders Dialog, enter Border1 for the Name, set
the Type to Open and press the Apply button.

•

After pressing the Apply button, the Create Border Color
Dialog pops up allowing you to set the color for the border.
Set the color to cyan by dragging the Red slider to the far
left, the Green and Blue sliders to the far right, and press the
OK button.

•

Move the mouse over the Main Window to the bottom of the
central sulcus. While holding down the left mouse button, drag
the mouse to the top of the central sulcus and release the left
mouse button.

•

Now, while holding down the Shift Key, click the left mouse to tell Caret that you are done drawing
the border and notice that its color changes from red to cyan as show in Figure 13.

Figure 13 – Open Border
Along Central Sulcus

Drawing a Closed Border
• Go back to the Draw Borders Dialog and change the name of
the border to Border2, change the Type of the border to Closed,
and press the Apply button.
•

In the Create Border Color Dialog set the color to magenta by
dragging the Green slider to the far left, the Red and Blue
sliders to the far right, and then press the OK button.

•

Move the mouse to the bottom of the central sulcus.

•

While holding down the left mouse button, draw the mouse in a
clockwise orientation around the perimeter of the central
sulcus.

•

Figure 14- Closed Border
Around Central Sulcus

When the mouse returns to a point near the starting point of
the border, release the left mouse button, hold down the shift
key and click the left mouse button to complete the border.
Notice that since this is a closed border, additional border points between the end and start of the
border are added as shown in Figure 14.

The next border will enclose the post-central sulcus. However, we do not want the border to overlap with
the border we just drew around the central sulcus so we will the use the augment feature while drawing this
border.
•

In the Draw Borders Dialog, change the name to Border3, leave the Type set to Closed, and press
the Apply button.

•

In the Create Border Color dialog, change the color to yellow by dragging the Blue slider to the far
left, the Red and Green sliders to the far right, and press the OK button.
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•

Move the mouse to the left side of the post-central sulcus. While holding down the left mouse
button start drawing the border in a clockwise direction.

•

When the mouse gets near the border that was drawn around the central sulcus, release the left
mouse button.

•

Hold down the CTRL key (Macintosh users should hold down the Apply key) and click the left
mouse button while over a point on the border that encloses the central sulcus. Notice that the
mouse pointer changes to a small cross. While still holding down the CTRL (Apple) key, click the
left mouse near the bottom left of the central sulcus border. Notice that the mouse returns to a
pointer shape.

•

Continue drawing the border by dragging the mouse with the
left mouse button held down to near the starting point of the
border.

•

Release the left mouse button, hold down the shift key, and
click the left mouse button to close the border as shown in
Figure 15.

When drawing a closed border, the paint attributes of the nodes within
the border may be assigned.
•

In the Draw Border Dialog, change the Name to Border4.

•

Set the Type set to Closed.

•

In the Closed Border Paint Assignment frame, check the Assign
Paint Identifiers to Nodes Within Border check box.

•

Set the Paint Column to Create New Column and enter Areas in the text box on the right.

•

Press the Apply button.

•

In the Create Border Color Dialog, choose a color for Border4 and press the OK button.

•

In the Set Area Color Dialog, press the Define Area Color button.

•

In the Create Area Color Dialog, choose a color for the nodes that is different than the color just set
for the border and press the OK button.

•

Use the mouse to draw a border by as described previously.

•

Using the Display Control Dialog, switch to the Overlay/Underlay – Surface panel.

•

Set the Primary Overlay to Paint and set the selected Paint to Areas. You should now see the nodes
within Border4 set to the color that you defined.

•

Press the Close button on the Draw Borders Dialog.

Figure 15. Closed Border
Around Post-Central Sulcus

Now that you have drawn some borders, you would like to see these
borders on the fiducial surface. However, it is difficult to draw
borders on a three-dimensional surface. So, the solution is to project
the flat borders.
•

While viewing the FLAT surface and the borders that you just
drew in the Main Window, select Layers:Borders: Project
Borders.

•

Choose Nearest Tile in the Projection Method Dialog that
pops up and press the OK button.

•

Change the surface in the Main Window to the FIDUCIAL surface and
set to a lateral view (Toolbar: L) to see the borders.

As an exercise, draw borders and assign nodes reproducing those show in
Figure 16.
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Figure 16. Border Drawing an
Assign Nodes Example

Surface Region Of Interest Operations
Region of interest operations allow measurements to be made of and operations performed on a subset of
the surface. There are three steps involved in performing a region of interest task in Caret 5. First, the
surface nodes of interest must be chosen. Secondly, the surface for the operation must be chosen. Lastly,
the operation and its parameters must be set.
Substantial flexibility is provided for node selection. Nodes may be selected by their paint attributes, metric
(functional) attributes, and their inclusion within a border. When selecting nodes by their paint attributes,
the paint attribute may be selected from a list or a node may be clicked with the mouse and the node’s paint
attribute will be obtained. Two methods are available for selecting nodes by their metric attributes. Both
allow the nodes to be filtered by upper and lower thresholds. The first method selects all nodes that are
within the upper and lower thresholds. The second method allows a node to be selected with the mouse and
then all nodes connected to the selected node whose metric values fall within the threshold are selected.
When selecting nodes within a border, the border may be selected by clicking it with the mouse or by
selecting the name of the border. An additional control is provided to select nodes in disjoint or intersecting
regions.
Several operations may be performed on the selected nodes with the Region Of Interest Dialog. These
operations include assigning paint attributes to nodes, creating a volume of interest (segmentation volume),
disconnecting nodes (breaking the links), performing geodesic distance measurements for a specific node,
smoothing selected nodes, and obtaining a statistical report.
Example of statistical report on a paint region:
•

Set the Main Window so that it displays the FLAT surface.

•

Using the Display Control Dialog’s Overlay/Underlay Surface panel set the Primary Overlay to Paint,
the Secondary Overlay to No Coloring, and the Underlay to Shape. Set the Paint to Lobes.

•

If borders are displayed, remove them using the Display Control Dialog’s Border panel.

•

Select Region of Interest Operations from the Surface menu and drag the Surface Region of
Interest Dialog the right of the Main Window.

•

In the Region of Interest Node Selection frame, set the Selection Method to Nodes With Paint.

•

Set the Category to Lobes. Press the Select Name From List button and, in the Paint Name
Selection Dialog that pops up, select LOBE.FRONTAL and press the OK button. Press the Select
Nodes button and you should see the frontal lobe turn green (selected nodes are shown in green).

•

In the Operation Surface and Topology frame, set the Surface to FIDUCIAL and the Topology to
CUT.

•

In the Operate on Selected Nodes frame, set the Operation to Statistical Report on Selected Nodes.
An option, Tab Separate Report (for import to spreadsheet), is provided which will separate the
columns in the report with tabs so that the report can be imported into a spreadsheet such as Excel.
Press the Create Report button, and, within a short time, the dialog will switch to the report output.

At the top of the report is information about the query and the number of nodes that were selected along
with the surface area of the entire surface and the selected region. In the metric section of the report,
statistics for the query nodes are provided for each column in the metric file. The same is true for the
surface shape file. In the paint section, information is provided showing the surface area and percentage of
total surface area that have the paint attribute and are within the query region. The report may be saved to a
file using the Save To File pushbutton or cleared with the Clear button.
Converting ROIs to Paint node attributes and a Segmentation Volume
•

Using the Display Control Dialog set the Primary Overlay to Metric, the Secondary Overlay to No
Coloring, and the Underlay to Shape. Set the selected Metric to Attn Shifts, Pop Avg.

•

Press the Query tab to return to the query page on the Surface Region of Interest Dialog.

•

In the Region of Interest Node Selection, press the Deselect Nodes button to clear the currently
selected nodes.
18

•

Set the Selection Method to Nodes With Metric. Set Threshold Low to 3.0 and High to 50000.0.
Select the Nodes Within Threshold Connected to Node Selected With Mouse.

•

Click the mouse over the Activation that is in parietal cortex (Point A in Figure 17). Setting the
Secondary Overlay to Paint – Lobes may help.

•

Press the Select Nodes button. You should see the activated area turn green, indicating that the
nodes are selected.

•

Below the Select Nodes button, change the control from Normal Selection to Or Selection (Union).

•

Click the mouse over the activation that is in the posterior part
of the frontal cortex (Point B in Figure 17) and press the Select
Nodes pushbutton. You should now see the two disjoint
activations in green indicating that they are selected as shown in
Figure 18.

•

In the Operation Surface and Topology frame, check to see the
Surface is FIDUCIAL and that the Topology is CUT.

•

In the Operate on Selected Nodes frame, set the Operation to
Assign Paint Attributes to Selected Nodes. Set the Paint
Column to Create New Column and in the text box on the right,
which contains the name for the new column, change it to
“Activations”. Set the Paint Name to “hotspot”. Press the Assign
Paint button. In the Create Area Color Dialog that pops up, set
the color to magenta by dragging the Green slider to 0, leave both
the Red and Blue sliders at 255, and press OK button.

Figure 17. Functional Regions
of Interest

•

In the Operate on Selected Nodes frame, set the Operation to Create Volume ROI from Selected
Nodes. Press the Create Volume Query From Displayed Query Nodes button. In the Create
Region Of Interest Volume Dialog’s Surface Selection frame,
set the surface to FIDUCIAL, Thickness to 1.0, Thickness
Step to 0.5, and the Offset to zeros. In the Volume Selection
frame change the Space to WU 711-2B 111. Press the OK
button. This may take a minute or two to complete.

•

Press the Deselect Nodes button in the Region of Interest
Node Selection frame.

•

Set the Main Window to display the FIDUCIAL surface.

•

On the Display Control Dialog’s Overlay/Underlay – Surface
panel, set the Primary Overlay to Paint with Activations as the
selected Paint and you should see two magenta regions
representing the regions selected.

•

Set the Main Window to display VOLUME.

•

On the Display Control Dialog’s Overlay/Underlay – Volume
panel, set the Primary Overlay to Segmentation, the Secondary
Overlay to No Coloring, and the Underlay to Anatomy.

•

Use the Toolbar to select a horizontal view. Set the selected slices to 131, 119,115. You should see
two red regions (segmentation volume voxels are always drawn in red) representing the activated
areas.

•

Set the Secondary Overlay to Functional and set the Functional Volume to Attention Shifts Pop Avg
to see the regions of interest in relation to the functional data.

Viewing Geodesic distances:
•

Change the Main Window to the FLAT surface.
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Figure 18. Functional Regions
Selected to ROI Operaton

•

Using the Display Control Dialog’s Overlay/Underlay – Surface panel, set the Primary Overlay to No
Coloring, the Secondary Overlay to No Coloring, and the Underlay to Shape.

•

In the Region of Interest Node Selection frame, set the Selection Method to Entire Surface.

•

Below the Select Nodes button, set the type of selection to Normal Selection.

•

Press the Select Nodes button.

•

In the Operation Surface and Topology frame, set the Surface to FIDUCIAL and the Topology to
CLOSED. It is important to use the closed topology to avoid inaccurate distances due to cuts.

•

In the Operate on Selected Nodes frame, set the Operation to Geodesic Distance. Press the
Choose Node With Mouse button and click the left mouse button inside the Sylvian Fissure.

•

Set the Metric Column to Create New Column and enter the name “Geo Dist”.

•

Leave the Geodesic set to Create New Column.

•

Press the Determine Geodesic Distances button. It may take several minutes to determine the
geodesic distances.

•

Press the Deselect Nodes button in the Region of Interest Node Selection frame.

•

Set the Primary Overlay to Metric. Set the Metric to Geo Dist.

•

Change the Display Control Dialog to the Metric panel. Set the Palette to Geodesic+. With this
palette, red represents nearby regions and yellow regions that are further away.

•

Change the Display Control Dialog to the Geodesic panel. Select the check boxes next to Enable
Geodesic Path for Identified Nodes and Show Root Node.

•

Click the mouse on different surface locations. The shortest path along the surface from the node
used to calculate the geodesic to the identified node will by displayed in cyan. This may function
best on the fiducial or inflated surfaces.

Converting a Surface to Volume
Caret 5 allows volumes to be created by intersecting a fiducial surface with a newly created empty volume.
Three different types of volumes may be created. Paint Volumes are created from a single column in a
currently loaded Paint File. Functional Volumes are created from a single column in a currently loaded
Metric File. RGB volumes are created using the current node coloring.
•

Select Attributes:Paint:Convert Paint Column to Paint Volume.

•

In the Copy Surface Paint Column to Paint Volume Dialog set
the Surface Selection to FIDUCIAL.

•

Set the Volume Selection Space to 711-2B-111 since the
tutorial surface is in 711-2B 111 space. This will automatically
set the parameters that specify the volume dimensions, voxel
size, and origin.

•

Set the Paint to Brodmann.

•

Press the OK button to create the Paint Volume. This may take
5 to 10 minutes.

•

Set the Main Window to VOLUME.

•

Using the Display Control Dialog’s Overlay/Underlay Volume
panel, set the Underlay Volume to Anatomy, the Primary
Overlay to Paint and the Secondary Overlay to No Coloring.

•

Scroll through the slices to view the Paint Volume overlayed on
the Anatomy Volume.

•

Since this volume took a while to create, you may want to save
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Figure 19. Brodmann Paint
Volume Over Anatomy

the volume. Select File:Save Data File to launch the Save Data File Dialog.
•

Set the File Type to Volume File – NIFTI (*.nii *.nii.gz), Volume File - WUNIL (*.ifh) or Volume File –
AFNI (*.HEAD) since these are the only formats that currently support Paint Volumes.

•

In the Save Parameters frame, set the Volume Type to Paint.

•

Enter a name for the file in the File Name text box.

•

Press the Save button to save the file. The file will be saved and the file information will
automatically added to the spec file.

Capturing Images of the Main Window
The contents of the Main Window may be saved to an image file. Caret 5 has two methods that it uses for
capturing the Main Window image. On some computer systems, one of the methods is preferable to the
other. The image capture method is selected on the Preferences Dialog available from the File Menu (on
the Caret 5 menu on Macintoshes). If the quality of the image is not as desired, try the other image capture
method. In addition, at times, a ghost image of the Save Image File dialog may appear in the image.
Alleviate this by dragging the Save Image File dialog off the Main Window prior to saving the image.
•

Select File Menu: Capture Image of Main Window menu item to pop up the Capture Main Window
Image Dialog.

•

In the Capture Type section, select Select Part of Graphics Area With Mouse.

•

In the Image Destination section, select Save to File. If you are on a Mac or Windows computer
with a word processor such as Microsoft Word, also select the Copy to Clipboard check box.

•

Verify the Name is set to capture.jpg.

•

In the main window, place the mouse outside of the surface, hold down the left mouse button, drag
the mouse so that a red box encloses the surface, and then release the left mouse button.

•

Press the Capture push button. A file in the current directory named capture.jpg will have been
created.

•

If you selected Copy to Clipboard, start your word processor and select Paste from the word
processor’s Edit menu. You should see the image you just captured pasted into your document.

Creating Movies
Caret 5 has the capability to successively capture images from the Main Window and save them to an
MPEG movie file. When recording, temporary image files are written to the current directory and
assembled into an MPEG movie file when the user presses the Create Movie button on the Recording
Dialog. Two methods of recording, Automatic and Manual, are available. Automatic recording captures an
image from the Main Window each time the graphics in the Main Window are updated. Manual recording
captures an image from the Main Window each time the Capture button on the Recording Dialog is pressed.
Prior to recording any images, the width and height of the movie image may be set. When the movie width
and height of a specific size is desired, it is best to start Caret 5 with the “-xy” option and specify the
desired width and height (ie: “Caret 5 -xy 352 240”). Since MPEG movies typically play at a rate of 30
frames per second, the Recording Dialog allows each captured image to be repeated an adjustable number
of times. Once the user has created a movie the Recording Dialog’s Reset button will clear any existing
temporary images allowing the user to start a new movie.
•

Switch to the Overlay/Underlay Surface panel on the Display Control Dialog. Set both the Primary
Overlay and the Secondary Overlay to No Coloring and the Underlay to Shape.

•

Set the Main Window to the INFLATED surface.

•

Place the surface in a lateral view using the Toolbar:L button.

•

Set the Main Window to the FIDUCIAL surface press the Toolbar:L button to place the fiducial
surface into a lateral view.
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•

Select Surface:Interpolate Surfaces to launch the Interpolate Surfaces Dialog and move the dialog
so that it does not obscure the Main Window.

•

In the Interpolate Surfaces Dialog, set the Interpolation Steps to 10. Set the Topology File to CUT
(…CartStd..). Set the First Surface to FIDUCIAL, Surface 2 to INFLATED, and Surface 3 to FLAT
(…CartStd). Set Surface 4 and Final Surface to None

•

Select File:Record As MPEG to launch the Recording Dialog and move the dialog so that it does not
obscure the Main Window.

•

Set Record Each Image to 5 times.

•

Select the radio button labeled Automatic so that images from the Main Window are automatically
captured.

•

Return to the Interpolate Surfaces Dialog and press the Apply button. The surfaces will be
interpolated and recorded which will take several minutes.

•

On the Recording Dialog, select the Manual radio button so that recording is off.

•

Press the Create Movie button to convert the temporary images into an MPEG movie file named
“output.mpg”.

•

View “output.mpg”. Windows and Macintosh users may double click the file to view it. Unix users
may use the program “mpeg_play” included in the Caret 5 distribution to view the movie.

•

Press the Reset button on the Recording Dialog to erase the temporary images.

View Right and Left Hemispheres Simultaneously
While Caret was originally designed to view a single hemisphere at a time, Caret is now able to load
multiple spec files. When multiple spec files are loaded, all of the surface and volumes are available in the
Model Selection Control on the Main and Viewing Windows. All operations and the Display Control
window operate on the Spec File containing the surface displayed in the Main Window.
•

Use the Display Control Dialog’s Overlay/Underlay – Surface panel to set the Primary Overlay to
Metric, the Secondary Overlay to No Coloring, and the Underlay to Shape.

•

Set the selected Metric to Attention Shifts Pop Avg.

•

Set the selected Shape to Folding (mean curvature).

•

Choose File:Open Spec File. In the Open Spec File Dialog,
navigate up one directory and then down into the
Left_HEM directory. Choose the only spec file.

•

In the Spec File Dialog press the Select All button followed
by the Load button to load all files. In the New Spec
Dialog, choose Keep Loaded Spec so that the right
hemisphere remains in memory.

•

Use the Display Control Dialog’s Overlay/Underlay –
Surface panel to set the Primary Overlay to Metric, the
Secondary Overlay to No Coloring, and the Underlay to
Shape.

•

Set the selected Metric to Attention Shifts Pop Avg.

•

Use the Main Window’s Model Selection control to select All
Fiducial Surfaces. You should now see both the right and
left hemispheres displayed.

•

Press the View button in the Main Window Toolbar. Hold
down the left mouse button and drag the mouse to rotate
the fiducial surfaces.
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Figure 20 Viewing Right and
Left Hemispheres

Scenes
(See also Section 1.11 of the Basics document)
Scenes provide a method for saving “the state” of Caret. By “state” we mean all loaded files, the models
displayed in the Main and Viewing Windows, and all Display Control settings. When making figures for a
paper or presentation it is often helpful to create a scene, so, if a change needs to be made to the figure, the
state of Caret at the time the original image was captured can be quickly reproduced.
Creating a scene:
• Open up at least one Viewing Window from the Window Menu.
• Set the overlays and underlay for the surfaces and/or volumes as desired.
• Switch to the Scene Page on the Display Control Window.
• Press the Append New Scene button and enter a name for the scene you are creating.
• Select Save Data File from the File Menu.
• In the Save Data File Dialog, set the File Type to Scene Files and enter a name for the scene file.
Press the Save button to save the file.
• Quit Caret by selecting Exit from the File Menu (use Quit Caret 5 from the Caret 5 Menu on
Macintoshes).
• Restart Caret 5 and reopen the Spec File you were just viewing (it should be the first item on the
File->Open Recent Spec File Menu.
• Press the Load Scenes button near the bottom of the Spec File Dialog.
• In the Display Control Window’s Scene Page, double-click the name of the scene you created in one
of the previous steps. It may take a minute or two to load the files and the state of Caret at the time
you created the scene will be restored.

Command Line Programs
Each of the command-line programs requires parameters for successful usage. To see a list of the
parameters and other help information, run the program with the parameter “-help”.
caret_command
caret_command is a command-line program for performing operations on surfaces and volumes on the command
line. Run the program with the argument “-help” to see a list of the program’s capabilities. The Script Builder,
available from the Window Menu, provides a user interface for building a script using caret_command.
caret_copy_spec
caret_copy_spec is a command-line program for copying a spec file. The data files may be copied
depending upon the parameters provided to the program.
caret_edit
caret_edit is a simple text editor that is able to edit all text files regardless of the type of newline characters.
For your information, Macintosh OSX, Microsoft Windows, and UNIX all use different characters to
indicate a newline in a text file. Thanks Bill Gates, Steve Jobs, and some unknown pocket-protectorwearing UNIX dork. The text editor may also be launched from Caret’s Window menu.
caret_file_convert
caret_file_convert is a command-line program that converts Caret 5 data files between text and binary
formats. It can convert a single file or many files.
caret_map_mfri
caret_map_fmri is a command-line program for mapping functional volume data to a surface.
caret_metric
caret_metric is a command-line program that performs clustering and smoothing of metric files.
caret_zip_spec
caret_zip_spec is a command line program for zipping a spec file and its data files into a “.zip” file.
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